
April 2016 Release Notes

The Alma April release provides numerous new features and enhancements. Some of these enhancements are a
result of the NERS or Idea Exchange initiatives.

Download a PDF of the Release Notes - Note that the PDF includes the online help pages that
describe the core functionality of the new features.
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Make the Most of This Release
Action Items

Patron Purchase Requests - Do you want your patrons to be able to request an item for purchase? If so, you can
enable this feature for Primo users to submit a request. Even when not enabled in Primo, a librarian can enter
purchase requests manually. An Alma user with the Selector role can view and edit the request, email a requester for
more information, and approve or reject the request.

Authority Control Task List - Finding it hard to monitor changes to bibliographic headings performed by the
authority control process? With the new Authority Control Task List, you can now monitor the changes in an efficient
manner and perform changes to headings when manual intervention is needed.

Control Global Authorities Displayed/Accessed in the MD Editor - Is your MD Editor navigation pane cluttered with
Community Zone global authority vocabularies that you are not using? You can now define which authority
vocabularies can be viewed and/or accessed in the MD Editor.

Expanding Booking Requests' Workflow - Are your patrons using booking requests to reserve resources for a
predetermined period of time? Were you interested in implementing this service but wanted more options included in
it? Now you can implement a richer workflow with booking requests, including full pick up from shelf and hold shelf
management options.

Broker Notification for a Renew Request and Receive Renew Status Update from Broker - If you are using a Relais
system as your broker resource sharing system, you can now enjoy a fully integrated renew process with Alma. New
NCIP-based features enable you to set up a fully integrated renew request process, from the time the patron requests
a renewal until the lender approval is received.

Automatic Rejection of New Lending Requests that Cannot be Fulfilled - If you are a resource sharing lender and
want to focus on fulfilling requests rather than on rejecting requests that cannot be fulfilled, this is what you’ve been
waiting for. With this feature, you can set Alma to automatically reject any new lending request that cannot be fulfilled
(for example, none of its inventory is available).

What's new in each Alma functional area for the April 2016 Alma release?

Acquisitions

Patron Purchase Requests - This new feature enables librarians using Alma and patrons using Primo to
request that a library purchase an item.
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Watch the Patron Purchase Requests video

Additional Invoice Charges - You can now configure additional special invoice line types and add up to five of
these line types to invoices.

Watch the Additional Invoice Charges video

Encumbrances Recalculated According to Current Exchange Rates - Open encumbrances and
disencumbrances based on PO lines with different currencies than their associated funds are now calculated
according to the correct exchange rates.

Additional Acquisitions Enhancements

Resource Management

Browsing Bibliographic Headings - Alma now supports browse functionality for authors, subjects, series, and
titles from within the MD Editor.

Authority Control Task List - The new Authority Control Task List enables you to review authority control issues
and manually handle headings corrections such as splits, ambiguous headings, and date period closures.

Watch the Authority Control Task List video

Control Global Authorities Displayed/Accessed in the MD Editor - Support is now provided for controlling which
global authorities can be viewed and/or accessed in the MD Editor.

Authority Control Based on Multiple Authority Identifiers in a Bibliographic Record - With new Metadata
Configuration options, you can identify how you want the system to handle matching and linking bibliographic
to authority records when there are multiple authority identifiers in the bibliographic record.

Multilingual Authority Record Preferred Term Support - Alma now supports authority control based on authority
vocabularies that contain multilingual preferred terms in one authority record.

Watch the Multilingual Authority Record Support video

Electronic Resource Editing Improvements - Several improvements to the electronic resource editors have
been made with a focus on better visualization of group settings for different levels of electronic resources.

Watch the E-Resource Editing Improvements video

KORMARC Non-Filing Indication - When working with KORMARC records, searching in the Alma repository
and browsing headings has been enhanced to include logic for processing records with non-filing indicators
and characters.
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Enhance Primo Publishing of MARC Bibliographic Records to Include Linked Data URIs - URIs may now be
added to bibliographic information for Primo publishing. This enhancement requires Primo-side configuration
that is available in Primo starting from the Primo May release.

Additional Resource Management Enhancements

Digital Resource Management

Enhancements for Handling of Special Representations

Configuring Representation Label Templates - You can now configure a template that can be used to create
a label for partial representations.

Auto Generate Labels - After you configure a representation label template, you can click the Auto-
Generate Label button when editing a partial representation to create a label based on the template.

Sorting and Find Options Available for Multiple Representations List - You can sort and search a list of
multiple representations.

Additional Digital Resource Management Enhancements

Fulfillment

Expanding Booking Requests' Workflow - Booking requests now participate in the standard request workflows.

Watch the Booking Requests' Workflow video

Support for RFID Readers - Scanning items with RFID readers is now supported.

Watch the Support for RFID Readers video

Sorting Citations in the Reading List - New sorting options are now available for the citations in a reading list.

Filter Get It Holdings and Items by Library Based on Primo View - Library mapping allows Primo views to be
mapped to one or more Alma libraries to offer an initial view with only the mapped libraries.

Enhancements for Resource Locate - A number of enhancements were added to the resource locate process
for citations on the Edit Reading List page.

Additional Fulfillment Enhancements
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Resource Sharing

Disabling Borrowing Reject Action - Libraries may now configure the borrower's ability to use the Reject action.

Automatic Rejection of New Lending Requests that Cannot be Fulfilled - Alma now automatically rejects a
lending request when the request cannot be fulfilled, or when the associated move request is canceled, which
alleviates the need for an operator to manually reject the request.

Broker Notification for a Renew Request - For Relais ILL and Relais D2D broker systems, Alma now notifies
the broker when an item renewal is requested by sending a RenewItem message to the broker with item
information and a desired due date.

Receive Renew Status Update from Broker - A broker system may notify Alma about the status of the renew
request.

New Fields in Resource Sharing Requests - Other Standard ID, DOI, Remote Record ID, and Barcode fields
have been added for resource sharing.

Add Contact Pop-up for Resource Sharing Partners - When a scanned item’s next step is to ship to a resource
sharing partner, the partner's name shows in the Scan In, Shipping Items, or Return interfaces, and the link for
the contact pop-up is now displayed.

Additional Resource Sharing Enhancements

Collaborative Networks

Integrating with the Aleph Central Catalog - Alma now supports the integration of Alma institutions with the
Aleph Central Catalog.

Analytics

Owning Location Code and Owning Location Name Added to Requests - The Owning Location Code and
Owning Location Name fields have been added to the Owning Library dimension of the Requests subject area.

Level of Service and Copyright Status Added to Borrowing Requests - The Level of Service and Copyright
Status fields have been added to the Borrowing Requests Details dimension of the Borrowing Requests subject
area.

Block Expiration Date and Block Expiration Date and Time Added to Users - The Block Expiration Date and
Block Expiration Date and Time fields have been added to the Block dimensions of the Users subject area.

Fine Fee Additional Transaction ID Added to Fines and Fees - The Fine Fee Additional Transaction ID field has
been added to the Fines and Fees Transactions dimension of the Fines and Fees subject area.
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Due to an upgrade of the OBIEE used by Alma Analytics, the export option for reports from Alma Analytics
to Excel 2003 will no longer be supported as of the Alma May release. Only export to an xslx format will be
supported and not export to an xls format.

Alma Infrastructure and Usability

You can view the hidden columns (Actions > View Hidden) for a row in a table. For details, see Customizing
List Tables.

Watch the Show Hidden Columns video

A NERS Enhancement: The maximum number of lines that can be exported to Excel was increased
to 100,000.

Right to left alignment (for Hebrew/Arabic letters) is now supported for most fields in Alma. Right to left support
is also available whenever a Hebrew or Arabic character appears in the MD Editor.

A new privilege REGISTER_NEW_USER was added to several roles, including Circulation Desk Manager,
Circulation Desk Operator, Circulation Desk Operator - Limited, General System Administrator, Repository
Manager, Trial Manager, Trial Operator, User Administrator, and User Manager. This privilege is required to
add new users.

Resource Management Usability Enhancements (see the Resource Management section above for more
information):

User Information Details Provided in the MD Editor

Electronic Resource Editing Improvements

Control Global Authorities Displayed/Accessed in the MD Editor

Fulfillment Usability Enhancements (see the Fulfillment section above for more information):

Expanding Booking Requests' Workflow

Sorting Citations in the Reading List

Resource Sharing Enhancement (see Resource Sharing section above): Automatic Rejection of a Lending
Request After a Move Request Cancellation
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Alma APIs

Alma API usage continues to grow as customers provide innovative services to their users. After careful review
of usage reports in recent months, we’ve increased the concurrent API request threshold to 25 API calls per
institution per second. The concurrent API request threshold applies to all API requests to the Ex Libris API
gateways.

As part of our continuing efforts to enable and encourage creative use of the APIs while ensuring the Alma
platform runs smoothly for all customers, API requests exceeding this threshold will receive an error message
starting 1 July 2016. To help plan for this change, requests exceeding the threshold during the interim period
will be marked with a warning message. It is recommended that you review your API applications in the coming
months to ensure that your integrations are not receiving these warning/error messages. For more information,
see https://developers.exlibrisgroup.com/alma/apis#concurrent-threshold

Support for digital representations was added to the Request for Services OpenURL API. Alma now returns
<key id="available_services">viewit</key> for bibliographic records that have only digital
inventory. For detailed information, see https://developers.exlibrisgroup.com/alma/integrations/discovery/
services_page.

The tracking ID for an error was removed from the error message and placed in a separate property, as
follows:

{

"errorsExist":true,

"errorList":{

"error":[

{

"errorCode":"401690",

"errorMessage":"Barcode is illegal.",

"trackingId":"E01-1910124003-ETEJZ-AWAE585113571"

}

]

},

"result":null

}

Ex Libris, a ProQuest Company
7

https://developers.exlibrisgroup.com/alma/apis#concurrent-threshold
https://developers.exlibrisgroup.com/alma/integrations/discovery/services_page
https://developers.exlibrisgroup.com/alma/integrations/discovery/services_page


Running GET /bibs/{mms_id in the Network Zone} on the Network Zone now retrieves an aggregate
list of AVE fields from all member institutions, including a subfield with the the member institution's mms_id.
For detailed information, see https://developers.exlibrisgroup.com/alma/apis/bibs.

The Create Bib API can now create bibliographic records in UNIMARC and KORMARC, in addition to MARC
21. For detailed information on this API, see https://developers.exlibrisgroup.com/alma/apis/bibs.

The <renewable> field was removed by default from GET /users/ID/loans, as it was causing system lag. If
you require this field, set the new Fulfillment parameter temp_add_renewable_to_get_loans_rest to true
(Fulfillment > Fulfillment Configuration > Configuration Menu > General > Other Settings).

Known Issues

When importing an EOD file using the New Order profile, if the location of the item does not have a call number
type, the call number type of the institution should be used as the alternative call number type. Currently,
however, no alternative call number is used.

Related to merging bibliographic records in the MD Editor, if there are no requests, the Merge Records and
Combine Inventory pop-up window does not display a count of 0 (zero) requests. The count appears for
requests only when it is greater than 0 (zero). The count should also appear as 0 (zero) requests when they
occur.

Regarding the autocomplete/pop-up assistance being provided for several UNIMARC fields in the MD Editor,
there is a known issue related to UNIMARC 327 $a and 327 $b. These subfields are based on the same
functionality and as a result, the pop-up suggestions in the MD Editor suggests both subfields’ values when
entering content in either the 327 $a or the 327 $b.

Fixed position fields cannot be modified using the extension loader (extension packs) at this time.

When creating an OCLC Connexion import profile in a Network Zone member institution with the Use NZ
option selected, the Use NZ record option is used upon finding a match. Currently, there is no possibility to
select the Merge, Overlay, or Do not import options instead.

When a record is deleted in Alma, the headings associated with the record are still available when browsing
bibliographic headings.

The Total electronic portfolios imported count in the MD import report does not take into account the
portfolios imported in the first file that is imported when the import is split into several files.
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Data Services

Library of Congress Genre/Form Terms thesaurus records were added to the Alma Community Zone. The
records will be updated weekly when updates are available. The following is an example of the way in which
you should link to the authority record:
Title: Survivor: Thailand.
655 #7 $a Survival television programs. $2 lcgft
655 #7 $a Nonfiction television programs. $2 lcgft

Library of Congress Authorities Community Zone Updates

New Electronic Collections Added to the Alma CKB

No new external search resources were added for this release
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Acquisitions - April 2016 Enhancements

Patron Purchase Requests

Patron purchase requests is a feature that enables librarians using Alma and patrons using Primo to request that a
library purchase an item. When enabled for display in Primo, a Primo user can request an item for any reason, for
example:

The library does not have a copy.

The library does not have enough copies or in the right format or edition.

The existing copy is damaged.

A librarian can enter a user's purchase request in Alma, even when the feature is not enabled in Primo. An Alma
user with the Selector role (Selectors) can view the list of requests and assign them to a Selector. Selectors can
edit a request, email a requester for more information, and approve or reject requests. Approved requests become
purchase order lines.

For detailed information, see Patron Purchase Requests.

Additional Invoice Charges

Until now, the special invoice lines Shipment, Insurance, Overhead, and Discount automatically appeared for
each new invoice, and you could add additional lines of these types, as well as lines of type Other or Regular.

An administrator can now configure additional special invoice line types and then add up to five of these line types
to invoices. For the list of types and how to configure them, see Configuring Invoice Line Types.

To configure line types, you must enable the invoice_split_additional_charges parameter on the Acquisitions
customer parameters page. Note that this parameter also affects how additional charges are handled in incoming
EDI invoices. For more information about both of these issues, see the invoice_split_additional_charges
parameter.

After configuring additional line types, an invoice operator or invoice manager can add invoice lines of these types
when creating or editing an invoice.
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For example, if the administrator enabled Sleeving as a line type, Sleeving appears as an option in the PO Line
dropdown box Add Invoice Dialog Box (click Add Invoice Line on the Invoice Lines tab of the Invoice Details
page). The operator can then add Sleeving as an invoice line type.

Add Invoice Dialog Box

To add the new additional charges to invoices:

1. While creating or editing an invoice, click Add Invoice Line in the Invoice Lines tab of the Invoice Details
page. The Add Invoice Line dialog box appears.

2. Select the line type from the Type drop down list. In this example, Sleeving is selected as the line type.

3. Enter any other required information, and click Add and Close. The line appears in the list of invoice lines.

Invoice Details, Invoice Lines Tab
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You can add up to five special invoice line types in each invoice. Alternately, the operator can add additional
charges using pro rata over all invoice lines.

To add the new additional charges pro rata over all invoice lines:

1. While creating or editing an invoice, click Use Pro Rata on the Summary tab of the Invoice Details page. The
additional charges fields appear.

Invoice Details, Summary Tab

2. Select the type from the Additional Charge dropdown and enter the value in the Amount field.
If you have enabled multiple additional line types, each time you select one of the line types from the
Additional Charge drop down list, another Additional Charge drop down appears, up to the total number of
additional line types that are enabled or until you have added five types of additional charges.

3. Make any other required changes and click Save or Save and Continue.

For more information on creating or editing invoice lines, see Creating Invoices.

Encumbrances Recalculated According to Current Exchange Rates

Open encumbrances and disencumbrances based on PO lines with different currencies than their associated
funds are now calculated according to the correct exchange rates. The exchange rate and date of open
encumbrances is updated by a job every week; the exchange rates and dates of their associated
disencumbrances are always the same as the encumbrances.
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For detailed information and an example, see Managing Funds and Ledgers. The new job is Recalculate PO Line
Encumbrances Based on Current Exchange Rates; see Viewing Scheduled Jobs.

Additional Acquisitions Enhancements

Alma configuration is now available only on the institution level.

The Owner field was added to the top of the Invoice Details page.

Invoice Details Page - Invoice Lines Tab

When attaching a PO line to an invoice line, the PO line owner appears in the list of PO lines and the list is
restricted to PO lines relevant to the invoice owner.

Invoice Details Page - Invoice Lines Tab

When an EDI invoice is loaded, if all of the associated PO lines of an invoice are owned by a particular library,
the invoice is also now owned by the library. Otherwise, the invoice is owned by the institution.
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Resource Management - April 2016 Enhancements

Browsing Bibliographic Headings

Alma now supports browse functionality for authors, subjects, series, and titles from within the MD Editor. Subject
searching also supports the option to choose a vocabulary, such as Library of Congress Subject Headings or
Medical Subject Headings, and a source code (for example, Genre/Form)

For detailed information about browsing bibliographic headings, see Browsing Bibliographic Headings.

Browsing by call number will be available in a future release.

Authority Control Task List

The Authority Control Task List provides more details regarding authority record updates and authority control
processes that are relevant to the institution's bibliographic record headings. The Authority Control Task List
makes it easier to manage cataloging maintenance tasks. Specifically, this list highlights authority headings
updates that require manual intervention.

For detailed information, see Using the Authority Control Task List.

Control Global Authorities Displayed/Accessed in the MD Editor

With the April release, support is provided for controlling which global authorities can be viewed and/or accessed
in the MD Editor. Metadata configuration options in Resource Management have been enhanced to allow you to
tailor the display of authority options when working in the MD Editor. With this new capability, you can limit the
display of options to only the vocabularies that you commonly use as opposed to all that might be available. These
same Metadata Configuration options also tailor the list of available Vocabulary code options that appear in the
drop-down list on the Import Profile Details page for an Authority type of profile.

This capability is specific to institutions that have had their authority usage policy configured for local
authorities.

For detailed information, see Controlling the Display and Access of Global Authorities in the MD Editor located on
the Configuring Cataloging page.
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Authority Control Based on Multiple Authority Identifiers in a Bibliographic
Record

With new Metadata Configuration options, you can identify how you want the system to handle matching and
linking bibliographic to authority records when there are multiple authority identifiers in the bibliographic record.

For detailed information, see Authority Control Based on Multiple Authority Identifiers in a Bibliographic Record on
the Working with Authority Records page.

After the Alma April 2016 release, GND customers affected by this change will be contacted individually to
implement this new improvement.

Multilingual Authority Record Preferred Term Support

With a new option available in the Metadata Configuration, you can configure the system to handle preferred term
support for multilingual authority records.

For detailed information, see Working with Multilingual Authority Record Preferred Terms on the Working with
Authority Records page.

KORMARC Non-Filing Indication

When working with KORMARC records, searching in the Alma repository and browsing headings has been
enhanced to include logic for processing records with non-filing indicators and characters. Sorted results lists
ignore non-filing characters and when browsing headings, the non-filing characters are ignored. For example,
articles such as a, an, and the can be ignored.

For detailed information, see Using Non-Filing Indicators in KORMARC located on Navigating the MD Editor Page.

Electronic Resource Editing Improvements

Several improvements to the electronic resource editors have been made with a focus on better visualization of
group settings for different levels of electronic resources. The following list highlights the changes that have been
made:

For consortial and multicampus environments, a new column labeled Available For Groups has been added
to the Available Services section of the Additional Information tab on the Electronic Collection Editor page.
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Available For Groups Column – Additional Information Tab

For consortial and multicampus environments, a new column labeled Available For Groups has been added
to the Portfolios tab on the Electronic Service Editor page.

Available For Groups Column - Portfolios Tab

If the list of group names displayed in a row under the Available For Groups column requires more than two
lines to display all of the groups, an ellipsis is added at the end of the content that can be displayed in those
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two lines and the complete list can be displayed as a tooltip when you position your cursor in the two lines that
are displayed.

Available For Groups Tooltip Display

For consortial and multicampus environments, group inheritance information from the collection and the service
is provided in the Group Settings tab on the Electronic Service Editor page and the Electronic Portfolio Editor
page, respectively. When there is a group setting for the collection and no group setting for the service, the
collection-level group setting displays in the Group Settings tab on the Electronic Portfolio Editor page. If you
add a group setting to a resource that has inherited group settings, a tooltip warning appears.

Group Settings Inherited from the Collection on the Service Editor Page

Group Settings Inherited from the Service
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Group Settings Inherited from the Collection on the Portfolio Editor Page

Tooltip Warning When Inherited Group Settings Exist

From the Group Settings tab on the Electronic Portfolio Editor page, the Coverage column now displays the
details of the coverage information specified for the group.

Coverage Details in the Group Settings Tab on the Electronic Portfolio Editor Page

Group Settings Coverage Details Entered

The electronic collection name is now hyperlinked text in the header area of the Electronic Collection Editor
page and the Electronic Service Editor page.
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Electronic Collection Editor Hyperlinked Name

Electronic Service Editor Hyperlinked Name

When you use the hyperlink to move about and make changes from tab to tab, your changes are maintained
but they are not permanently saved until you click the Save button in either the Electronic Collection Editor or
the Electronic Service Editor.

The service type is now hyperlinked text in the header area of the Electronic Service Editor and the Electronic
Portfolio Editor page.

Electronic Service Editor Hyperlinked Service Type
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Electronic Portfolio Editor Hyperlinked Service Type

From the electronic resource editor pages, the record ID for electronic resources has been added for
information purposes in the following manner:

The portfolio record ID, service record ID, and electronic collection record ID appear in the Portfolio tab on
the Electronic Portfolio Editor page.

Electronic Resource Record IDs in the Portfolio Information Tab on the Electronic Portfolio Editor Page

The service record ID and electronic collection record ID appear in the Service Description tab on the
Electronic Service Editor page.

Electronic Resource Record IDs in the Service Description Tab on the Electronic Service Editor Page

The electronic collection record ID appears in the General Information tab on the Electronic Collection
Editor page.
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Electronic Resource Record ID in the General Information Tab on the Electronic Collection Editor Page

Enhance Primo Publishing of MARC Bibliographic Records to Include
Linked Data URIs

Primo publishing may now include URIs in addition to the regular bibliographic information. The URIs are entered
in the 0 subfield of the relevant fields.

A sample of the enriched record follows:

700 1 |a Lockyer, Norman, |c Sir, |d 1836-1920.
|0 (uri) http://id.loc.gov/authorities/names/n86860325
|0 (uri) http://viaf.org/viaf/sourceID/LC|n86860325

650 0 |a Science |v Periodicals.
|0 (uri) http://id.loc.gov/authorities/subjects/sh85118580

For information on configuring linked data enrichment, see http://knowledge.exlibrisgroup.com/Alma/
Product_Documentation/Alma_Online_Help_(English)/Alma-Primo_Integration/Publishing_Alma_Data_to_Primo/
Exporting_Alma_Records_to_Primo#ww1352217

Additional Resource Management Enhancements
User information details displayed in a pop-up window have been added to the Templates tab and the Rules
tab in the MD Editor. Specifically, this has been added for Created by and Last updated by user information.
When you view the properties for templates or normalization, merge, or indication rules and click the user ID
link, the user information details appear. See the illustrations below.
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Properties Option

User ID Link
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User Information Pop-Up

The user information link to display the user pop-up window is active for rules (or templates) that have been
locally created in the Shared or Private folders. For rules (or templates) obtained from the Community, no user
pop-up link is provided.

With the March release of Alma, sharing rules (normalization, merge, and indication in the MD Editor) in the
Community Zone was introduced. In April, several enhancements have been incorporated into this capability,
such as filtering and a Properties option in the drop-down list of the Community folder. For more information
about these enhancements that have been added, see Contributing to the Community Zone - Normalization,
Merge, and Indication Rules.

Watch the Contributing Normalization Rules to the Community Zone video

In order to start maintaining URLs in the Community Zone, the ability to locally override the URL value of an
activated Community Zone collection has been added. URLs will be added to the Community Zone collections
in upcoming releases.

A new drool combineFields can be used to combine all fields of the specified number. All subfields of the
second and subsequent lines will be combined into the first line unless excluded (only the first occurrences of
excluded subfields are copied into the first line, and only if they don't already exist in the first line). For more
information, see Working with Normalization Rules.
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Fulfillment - April 2016 Enhancements

Expanding Booking Requests' Workflow

The workflow for booking requests was expanded to include steps for picking up booked items from the shelf, for
putting them in transit to the required pickup location, and for placing them on the hold shelf. This greatly expands
the booking services a library can offer to its patrons.

For detailed information about the booking requests' workflow, see Booking Workflow.

Support for RFID Readers

Alma now supports using 3M RFID readers (model 896) for scanning items and for their check-in and check-out.

For detailed information about RFID and the integration profile setup, see RFID Support.

Sorting Citations in the Reading List

You now sort citations in a reading list using the new reading_list_citation_sorting configuration parameter with
one of the following values: Title, Author, Call Number, and Create Date. The default sort is by title. If you
select call number, and the citation contains more than one call number, only the first number is considered.

Items that start with special characters (i.e. “, (, ), $, etc.) affect the sorting. These items appear at the top
of the listing.

For information about configuring citation sorting, see the Other Settings Options table in Configuring Fulfillment
Jobs.

Filter Get It Holdings and Items by Library based on Primo View

Primo views of the GetIt tab may now be mapped to one or more Alma libraries. When this is configured, the initial
GetIt tab view is filtered to view only libraries which have been mapped to the Primo view. A message indicates
that a filter is in place and includes the option to switch back to a view showing all libraries. If there is no such
configuration, the filter text does not appear.
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Primo Filtered View

For information on mapping a Primo view to Alma libraries, see Mapping Primo Views to Libraries.

Enhancements for Resource Locate

A number of enhancements were added to the resource locate process for citations on the Edit Reading List page.

When you create a citation that is not attached to an inventory item, or when you click Resource Locate
beneath a citation that is not attached to an inventory item, Alma tries to find a single inventory item to which to
attach the citation. If it succeeds, the citation is automatically attached to the inventory item. This matching is
controlled in the new Match by Fields code table. The search automatically uses the tag "suppressed=false" to
avoid returning suppressed items.

When there are multiple matches, Alma now displays a repository search page enabling you to select a match
or edit the search criteria

When there are no matches, Alma now displays a repository search page enabling you to edit the search
criteria.
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For more information, see Managing Citations.

Additional Fulfillment Enhancements

Click Purchase Request beneath a citation on the Edit Reading List page to add a patron purchase request for
the citation. For more information, see Patron Purchase Requests.

Edit Reading List Page

You can now associate a reading list with a course (or remove the association) from the Reading List Task List
page.
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Reading List Task List Page

To associate a reading list with a course, or to change the reading list's course association, select Actions >
Associate this list with a course, select or search for the new course in the pop-up window, and click Change
Course Association.

Course Association Pane

To remove a course association, select Actions > Remove associated course.

The tab-separated file to be read by the course loader integration profile can now end in .txt as well as .csv
(the format of the file has not changed).

Request fields for partial digitization requests are now displayed in the Notes field on Manage In Process Items
and Approval Request List pages.
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Approval Requests List

The user information pop-up was added to the Loan Audit Trail page for:

Borrower

Requester Name (for recalled loans)

Operator

The new user parameter, hide_single_holding_getit_details controls the Get It display when a single
holdings' items are shown. The parameter, when set to True, opens the single holdings' items page with the
details hidden, with an option to show details. The default is False, which opens the page with the holdings'
item already expanded.

In the Change Item Information tab of the scan-in Interface, a new value, None, was added to the Item policy
drop-down list. Selecting None removes the value previously selected.

The Personal Delivery pickup options labels in the Get It tab can now be customized in Fulfillment >
Fulfillment Configuration > Configuration Menu > Discovery Interface Display Logic > Labels. The labels
are:

personal_delivery

personal_delivery.home_address

personal_delivery.work_address

For cases in which an item was marked as missing and is then scanned in, a pop-up confirmation message
was added to notify the operator that the missing label was removed from this item. The message appears in
the following interfaces:

Scan In Items

Manage Item Returns

Manage Patron Services - Returns tab
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To support Patron Purchase Requests from Primo, a new purchase request display feature was added to the
Discovery Interface Display Logic rules.

You can add tags in the Tags tab when editing a citation. In addition, you can filter the list of citations on the
Edit Reading List page using these tags. If you have Leganto, you can also add or edit the available tags (see
Using Expanded Tagging in the March 2016 Leganto Release Notes).

Edit Reading List Citation Page - Tags Tab

Edit Reading List Page
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Resource Sharing - April 2016 Enhancements

Disabling Borrowing Reject Action

The borrower’s ability to use the Reject action for borrowing requests may now be configured by the library. This is
particularly useful for ISO requests, where the rejection is expected to be received as a message sent by the
lender.

This function introduces a new workflow option, Reject, which is turned on by default. When a workflow profile is
selected and the workflow step is disabled, the Reject action disappears from the borrowing request and from the
Rota tab of the request. The option still exists in the list of actions in the drop-down list at the top of the borrowing
requests. If the reject action is selected from the list, the reject action is not executed and an alert appears at the
top of the list. If a workflow profile is not selected, the Reject action is enabled. If the request does not have a
partner, the reject option is unavailable.

To configure the workflow option, see the Workflow Profile Steps table in Adding Workflow Profiles.

Automatic Rejection of New Lending Requests that Cannot be Fulfilled

Lending requests for ISO partners can now be automatically rejected if the request cannot be fulfilled. This may
also be relevant for SLNP and NCIP P2P partners. The new options for automatic rejection are:

Reject a request when the locate process did not find any matches

Reject a request when there are no items that are available in place and requestable for resource sharing, per
policy

Reject a request when only an electronic resource is available

To configure the resource sharing library for these new options, see Configuring Libraries.

Alma now also automatically rejects a lending request when the associated move request is canceled, which
alleviates the need for an operator to manually reject the request. No configuration is necessary. If there is more
than one partner on a borrowing request and the partners are of type ISO, once the move request has been
canceled and the lending request rejected, the borrowing request moves on to the next partner. If there are no
further partners, the borrowing request status is set to Rejected by partner.

The lending request and borrowing request both contain notes to indicate when an automatic rejection has
occurred.
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Lending Request Notes After an Automatic Rejection

Borrowing Request Notes After an Automatic Rejection

This enhancement is applicable only for ISO, SLNP, NCIP P2P, and email partners. Other partners are not
affected.

Broker Notification for a Renew Request

For Relais ILL and Relais D2D broker systems, Alma will now notify the broker when an item renewal is requested
by sending a RenewItem message to the broker with item information and a desired due date. The broker
responds with a pending status and possibly a DateOfExpectedReply. This means that a fully integrated process is
now possible when using a Relais system with Alma. The patron (from Primo) or the staff (from Alma) can request
a renewal without that renewal request requiring re-entering into the Relais system. Instead, the Relais system is
automatically updated by the RenewItem message sent from Alma.

The partner record now contains a URL to indicate where the message is sent. This must be entered in order to
send the notifications to the broker system.

To configure the resource sharing partner, see Resource Sharing Requests.
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Receive Renew Status Update from Broker

A broker system may notify Alma about the status of the renew request. Alma then receives an NCIP
CirculationStatusUpdated message with a circulation status of:

Renew Still Pending - Marks the request as Renew Requested.

Item Not Renewed - Manages the request as it does when a renew request is rejected.

These messages have been implemented by the Relais systems. Together with the 'Broker Notification for Renew
Request' feature, Alma now supports a fully integrated renew workflow with the Relais system.

For more information on NCIP messages, see the developer network: https://developers.exlibrisgroup.com/alma/
integrations/resource_sharing/broker/ncip

New Fields in Resource Sharing Requests

Other Standard ID, Remote Record ID and Barcode fields were added to the Alma lending and borrowing
request forms. The fields were not added to the Primo forms.

Other Standard ID, DOI, Remote Record ID and Barcode were added to the Locate By field options of the
Locate Profile.

For more information on the locate by process, see Locating Items.

Add Contact Pop-up for Resource Sharing Partners

When a scanned item’s next step is to ship to a resource sharing partner, the partner's name shows in the Scan In,
Shipping Items, or Return interfaces. The link for the contact pop-up is now displayed, containing the partner’s
emails and address. For the address to show in the pop-up, the partner must have an address with the address
type of Shipping.
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Scan In Items

Shipping Items
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Returns

Additional Resource Sharing Enhancements

ILL SBN has been added as an option for System type when selecting the ISO profile type.

A new customer parameter, rs_external_id_prefix, was created to configure the external identifier format.
Possible values are code or id. If set to code, the external ID is created as {institution code + a generated
number} (as it has been up until now). If set to id, the external ID is created as {customer Id + institution id + a
generated number}.
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Digital Resource Management - April 2016
Enhancements

Configuring Representation Label Templates

You can create a template that can be used to create a label for partial representations. These representations are
used when a bibliographic record is not fully represented by a single representation. For detailed information about
creating such templates, see Configuring Representation Label Templates.

Auto-Generate Labels

After you configure a representation label template, you can click the Auto-Generate Label button when editing a
partial representation to create a label based on the template. For more information, see Editing
Representation Metadata and Content.

Sorting and Find Options Available for Multiple Representations List

When clicking View It and More... for a bibliographic record with multiple representations, the complete list of
representations appears with sort and find options. For example:
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Sort and Find for Multiple Representations List

You can sort the results by:

Volume

Issue

Date

For more information, see Viewing Digital Representations.

Additional Digital Resource Management Enhancements

Various issues associated with the creation and editing of Dublin Core records in the MD Editor were fixed.
Additionally, documentation has been added describing how to create Dublin Core records in the MD Editor. [to
be added within the next few days]

It is now possible to remove the Dublin Core options from the MD Editor. For more information, contact Ex
Libris Support.
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Collaborative Networks - April 2016 Enhancements

Integrating with the Aleph Central Catalog

Alma supports the use of the Aleph Central Catalog to allow Alma institutions to perform the following functions:

Copy cataloging from the central catalog

Contribute changes to the central catalog from Alma

Publish inventory to the central catalog from Alma

Import changes from the central catalog to Alma

For detailed information, see Integration of the Aleph Central Catalog.
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Analytics - April 2016 Enhancements

Owning Location Code and Owning Location Name Added to Requests

The Owning Location Code and Owning Location Name fields have been added to the Owning Library
dimension of the Requests subject area. These fields allow you to create Analytics reports according to the
location of the requested item—for example, the number of patron physical item requests from an offsite location
during a specified request date period.

Owning Location Code and Owning Location Name Fields

The following is an example of a report using the new fields:
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Owning Location Code and Owning Location Name Fields Report

For more information, see Owning Library.

Level of Service and Copyright Status Added to Borrowing Requests

The following fields have been added to the Borrowing Requests Details dimension of the Borrowing Requests
subject area.

Level of Service - Allows you to create reports with the borrowing request level of service, to more deeply
analyze the nature and workflow of the borrowing request.

Copyright Status - Allows you to filter reports by copyright status to display which requests have a copyright
that may need further processing.
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Copyright Status and Level of Service Fields

The following is an example of a report using the Copyright Status field:
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Copyright Status Field Report

The following is an example of a report using the Level of Service field:

Level of Service Field Report

For more information, see Borrowing Request Details.

Block Expiration Date and Block Expiration Date and Time Added to
Users

The Block Expiration Date and Block Expiration Date and Time fields have been added to the Block
dimension of the Users subject area. These fields allow you to create reports according to the block expiration
date and the block expiration date and time.
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Block Expiration Date and Block Expiration Date and Time Fields

The following is an example of a report using the new fields:

Block Expiration Date and Block Expiration Date and Time Fields Report

For more information, see Block.

Fine Fee Additional Transaction ID Added to Fines and Fees

The Fine Fee Additional Transaction ID field has been added to the Fines and Fees Transactions dimension of the
Fines and Fees subject area. (This is in addition to the existing Fine Fee Transaction ID field, which stores the
unique identifier of the fine or fee transaction.) The new Fine Fee Additional Transaction ID field is useful, for
example, in identifying fine and fee transactions that are handled via the APIs.
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Fine Fee Additional Transaction ID

The following is an example of a report using the new field:

Fine Fee Additional Transaction ID Report

For more information, see Fines and Fees Transactions.
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Data Services - April 2016
The Alma March Central KnowledgeBase and Community Zone package was applied to the Alma environments.

Library of Congress Authorities Community Zone Updates

The following are the Library of Congress Subject authority updates for the period of February 25th through March
23rd

Number of records updated: 78

Number of records added: 238

Number of records deleted: 14

The following are the Library of Congress Name authority updates for the period of February 25th through March
23rd:

Number of records updated: 12477

Number of records added: 18671

Number of records deleted: 285

The following are the Canada name authority file updates for the period of February 25th through March 23rd:

Number of records added: 1151

New Electronic Collections Added to the Alma CKB

The following collections were added to the Alma Community Zone during February 29, 2016 through and March
27, 2016:

De Gruyter eBooks Arts Architecture and Design 2015

De Gruyter eBooks Classical and Ancient Near Eastern Studies 2015

De Gruyter eBooks Economics 2015 De Gruyter eBooks Engineering, Computer Sciences 2015

De Gruyter eBooks History 2015 De Gruyter eBooks Law 2015

De Gruyter eBooks Library and Information Science 2015
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De Gruyter eBooks Linguistics 2015

De Gruyter eBooks Literary Cultural and Area Studies 2015

De Gruyter eBooks Mathematics 2015

De Gruyter eBooks Medicine and Life Sciences 2015

De Gruyter eBooks Philosophy 2015

De Gruyter eBooks Physics, Chemistry, Industrial Chemistry, Materials Sciences, Geosciences 2015

De Gruyter eBooks Social Sciences 2015

De Gruyter eBooks Theology and Religious Studies, Jewish Studies 2015

ebrary Social Sciences Subscription

JUSTICE Oxford University Press 2016

Medical*Online E-Books Library (買切り制)

Project Muse eBooks 2016

ProQuest British Periodicals - British Periodicals Collection IV

ProQuest Harper's Bazaar Archive

ProQuest Historical Newspapers: Chinese Newspapers Collection

ProQuest Historical Newspapers: The American Israelite

ProQuest PAO Periodicals Online Foundation Collection 2

ProQuest Periodicals Archive Online Jisc Collection 2

ProQuest Periodicals Archive Online JSTOR Titles

ProQuest Women's Magazine Archive

ProQuest Women's Magazine Archive I

Scientific.net Materials Science Foundations

TAEBDC ABC-Clio eBooks 2008

TAEBDC ABC-Clio eBooks 2009

TAEBDC ABC-Clio eBooks 2010

TAEBDC ABC-Clio eBooks 2011

TAEBDC ABC-Clio eBooks 2012

TAEBDC AiritiBooks 2011

TAEBDC AiritiBooks 2012

TAEBDC Books@Ovid 2009

TAEBDC Books@Ovid 2010

TAEBDC Books@Ovid 2011
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TAEBDC Books@Ovid 2012

TAEBDC Cambridge Books Online (CBO) 2008

TAEBDC Cambridge Books Online (CBO) 2009

TAEBDC Cambridge Books Online (CBO) 2010

TAEBDC Cambridge Books Online (CBO) 2011

TAEBDC Columbia University Press eBooks 2009

TAEBDC CRC netBase eBooks 2008

TAEBDC CRC netBase eBooks 2012

TAEBDC Ebrary eBooks 2009

TAEBDC Ebrary eBooks 2010

TAEBDC Ebrary eBooks 2011

TAEBDC Ebrary eBooks 2012

TAEBDC Elsevier ScienceDirect eBooks 2009

TAEBDC Elsevier ScienceDirect eBooks 2010

TAEBDC Elsevier ScienceDirect eBooks 2011

TAEBDC Elsevier ScienceDirect eBooks 2012

TAEBDC Emerald eBooks 2011

TAEBDC Gale eBooks 2009

TAEBDC Gale eBooks 2010

TAEBDC HyRead eBooks 2011

TAEBDC HyRead eBooks 2012

TAEBDC IGI Global InfoSci Books 2011

TAEBDC IGI Global InfoSci Books 2012

TAEBDC Informa Healthcare eBooks 2011

TAEBDC Informa Healthcare eBooks 2012

TAEBDC IOS eBooks 2008

TAEBDC IOS eBooks 2009

TAEBDC IOS eBooks 2010

TAEBDC IOS eBooks 2011

TAEBDC IOS eBooks 2012

TAEBDC Karger eBooks 2011

TAEBDC Karger eBooks 2012
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TAEBDC L&B eBooks 2011

TAEBDC L&B eBooks 2012

TAEBDC McGraw-Hill Chinese eBooks 2011

TAEBDC McGraw-Hill eBooks 2010

TAEBDC McGraw-Hill eBooks 2011

TAEBDC McGraw-Hill eBooks 2012

TAEBDC MyiLibrary eBooks 2008

TAEBDC MyiLibrary eBooks 2009

TAEBDC NetLibrary eBooks 2008

TAEBDC NetLibrary eBooks 2009

TAEBDC NetLibrary eBooks 2010

TAEBDC Oxford Scholarship Online (OSO) eBooks 2008

TAEBDC Oxford Scholarship Online (OSO) eBooks 2009

TAEBDC Oxford Scholarship Online (OSO) eBooks 2010

TAEBDC Oxford Scholarship Online (OSO) eBooks 2012

TAEBDC Palgrave Connect eBooks 2010

TAEBDC Palgrave Connect eBooks 2012

TAEBDC Sage eBooks 2008

TAEBDC Siam eBooks 2008

TAEBDC Siam eBooks 2012

TAEBDC Springer eBooks 2008

TAEBDC Springer eBooks 2009

TAEBDC Springer eBooks 2010

TAEBDC Springer eBooks 2011

TAEBDC Springer eBooks 2012

TAEBDC Taylor & Francis eBooks 2010

TAEBDC Taylor & Francis eBooks 2011

TAEBDC World Scientific eBooks 2012

New External Search Resources

No new external search resources were added for this release.
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Patron Purchase Requests

The following roles are required to perform patron purchase request tasks:

Creating requests: Any role

Managing requests: Selector

Delete rejected requests: Selector + Selector Extended

Patron purchase requests enables librarians using Alma and patrons using Primo to request that a library
purchase an item. The requester can request an item for any reason, for example: the library does not have a
copy, or the library does not have enough copies or in the right format or edition, or the existing copy is damaged.
The requester (or a librarian on behalf of a requester) fills in as many details of the item as possible and then
sends the request to Alma for review.

An Alma user with the Selector role (Selectors) can view the list of requests and assign each one to himself/
herself or to another user. Selectors can edit a request, email a requester for more information, and approve or
reject requests. Approved requests become purchase order lines.

To support this feature, two new letters were added to Alma:

Purchase Request Status Letter – Sent to requester when the request is approved or rejected.

Query to Requester – Sent to the requester when the librarian queries him or her for more information.

For more information, watch the Patron Purchase Requests video (3:46)

Patron purchase requests are a service exposed from Alma to Primo.
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Patron Purchase Request Link in Primo

Like any other service, it can be hidden from groups of users using Alma’s Display Logic Rules. This
service is currently hidden from all users by default with the rule Hide Service Purchase Request.

To enable the service for all Primo users, remove this rule.

To hide the service only for specific groups, remove this rule and then add a rule/rules to hide the
service for those groups.

You can also configure all labels used for this feature.

For more information about configuring display logic rules and configuring labels, see Discovery Interface
Display Logic.

Creating a Purchase Request

A patron can create a purchase request in Primo. Requests made by patrons in Primo are submitted to Alma with
the status In Review. A brief bibliographic record is created for the requested item, if required.

You can also create a patron purchase request on behalf of a user in Alma. You can do this:

One way to do this is when managing citations in a reading list (see Managing Citations).

On the Purchase Request page (see below).

To create a patron purchase request on the Purchase Request page:

1. On the Purchase Request page (Acquisitions > Purchase Requests > Create Purchase Request), fill in as
much information as you can.
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Alma: Purchase Request Page

For a description of the fields in the Resource Information area, see Adding a New Book or Journal Article. The
fields in the Request Attributes area are as follows:

Requested Format – Whether the item should be acquired in electronic or physical format

Requester – The user who is making the request

Request Status – The initial status of the request, which is always In Review

Owning Library – The library that should receive the item

Estimated Cost – An estimated cost for the item, including the currency

Fund – The fund from which to purchase the item. This field is only active after a library is selected.

Vendor/Account – The vendor and vendor account from which to purchase the item

Approved By – This field is initially empty. It will later contain the name of the user who approved the item,
if any.

Requester Note – Any note to send to the user who will be approving or rejecting the request.

Rejection Reason – This field is initially empty. This field will later contain the reason the request was
rejected, if any.

The fields Title and Requester are mandatory.

Instead of entering the information manually, you can click Locate, search for and select an item in the
repository, and click Select. The item’s information is pre-filled in the page’s fields.

2. If you enter a Library, you can add locations and the number of requested copies for each location in the
Quick Add area. If you do not specify quantities and locations, one copy in the default Acquisitions location is
assumed.

3. Add any notes in the Notes tab, as required.

4. When you are done, click Save.

The request is submitted with the status In Review. A brief bibliographic record is created for the requested
item, if required.

Managing Patron Purchase Requests

The following tasks are available to manage patron purchase requests:

Viewing Pending Purchase Requests

Assigning a Patron Purchase Request
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Editing a Patron Purchase Request

Emailing a Patron Purchase Request

Approving or Rejecting a Patron Purchase Request

Viewing Pending Purchase Requests

To view pending purchase requests, select Acquisitions > Purchase Requests > Manage Purchase Requests
from the Alma Main Menu. Alternately, if there are any unassigned requests, or there are any requests assigned to
you, select one of the following tasks from the Tasks List in the persistent menu:

Purchase requests - assigned to you

Purchase requests - unassigned

Manage Purchase Requests Page
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Use the tabs to see requests assigned to you or to others, or to view unassigned requests. Use the facets and the
Find tool to filter the list of requests on the page.

To view more details about the requested item:

Click a request title to view the request in the MARC Record Simple View page.

In the Unassigned or Assigned to Other tab, click View beneath a request to view the request details. The
View link only appears in the Unassigned tab if the request was ordered or rejected.

Assigning a Patron Purchase Request

You can assign a patron purchase request to a user or release an assignment. The user to which the request is
assigned should approve or reject the request.

To assign requests to a user:

1. Click Assign to beneath a request. A dialog box appears.

Assign To Dialog Box

2. Select the user to whom to assign the request. Only users with the relevant role appear in the dropdown list.

3. Optionally add a note and select whether to send an email to the user.

4. Click Assign To.

The request is assigned to the selected user.

To move a request back to unassigned:

In the Assigned to Me or Assigned to Others tab, click Release Assignment beneath a request. The request is
moved back to the Unassigned tab.

Editing a Patron Purchase Request

You can edit a patron purchase request.
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To edit a request:

1. In the Assigned to Me or Unassigned tab, click Edit beneath a request. The Purchase Request page
appears. For more information, see Creating a Patron Purchase Request.

2. Change any fields, as required. When you are done, click Save.

If the request was not already assigned to you, it is now assigned to you.

Emailing a Patron Purchase Requester

You can email the requester for more information about a patron purchase request.

To send email to the requester:

1. Click Send Query to Requester beneath any request. An Email Message dialog box appears.

E-Mail Message Dialog Box

2. Enter information in the fields. The From, To, and Subject fields are mandatory. Note that if the requester’s
email is not prefilled, you must enter it manually.

3. When you are done, click Send E-Mail. An email (Query to Requester) is sent to the requester.
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Approving or Rejecting a Patron Purchase Request

Approving a patron purchase request creates a purchase order line. Whether you approve or reject the request,
Alma sends an email to the requester.

To create a purchase order line for the request:

Before ordering the item, ensure that a library and/or location is selected in the request. If one is not selected, edit
the request; see Editing a Patron Purchase Request.

Click Approve and Order beneath a request. A PO line is created. The PO line number appears in the
confirmation message at the top of the page. Alma sends the requester a confirmation letter (Purchase Request
Status Letter).

To reject a request:

1. Click Reject beneath any request. A confirmation dialog box appears.

Alternately, you can reject multiple reasons at once: Select the check boxes next to the reasons that you want
to reject and click Reject Selected at the top or bottom of the page. You can select all the requests on the
page by clicking Select All at the top of the list of requests.

2. Click Confirm in the confirmation dialog box. A reject reason dialog box appears.

Reject Reason Dialog Box

This list of reasons can be configured by an administrator.

3. Select the reason for the rejection and click Reject. The request is rejected. If the request created a brief
bibliographic record, it is also deleted. Alma sends the requester a confirmation letter (Purchase Request
Status Letter).

After a request is rejected, it appears in the list of requests with the option to delete the request. To delete the
request, click Delete beneath the request.

To delete a patron purchase request, you must have the Selector Extended role.
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Configuring Invoice Line Types

The following roles can configure which additional charges are available to add to invoices:

Acquisitions Administrator

General System Administrator

Out of the box, the special invoice lines Shipment, Insurance, Overhead, and Discount automatically appear for
each new invoice, and you can enable additional lines of these types, as well as lines of type Other or Regular.

You can enable additional line types that can be added to invoices on the new Invoice Line Types code table
(Acquisitions > Acquisitions Configuration > Configuration Menu > Invoices > Invoice Line Types). This link
appears only after enabling a parameter in the Customer Parameters mapping table (see below).

You can enable as many line types as you like. However, each invoice can only contain up to five types of
invoice line.
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Invoice Line Types Code Table

For more information, watch the Additional Invoice Charges video (2:36)

The lines that can be made available for invoices include:

All

Regular

Other

Additional Charges

Shipment

Insurance

Ex Libris, a ProQuest Company
57

http://knowledge.exlibrisgroup.com/Alma/Training/01_What's_New_Videos_2016/09_April_2016_Release/Additional_Invoice_Charges


Discount

Overhead

Supply of approvals/book collections

Barcode labelling

Classification

General servicing by library bookseller

Binding

Sleeving

Data communication

Miscellaneous servicing

Audio/CD-ROM packaging

Security fitting

Cataloguing services

Commission

Delivery

Exchange rate guarantee charge

Handling charge

Small order surcharge

Insurance charge

Posting charge

Packing charge

Postage and packing charge

Special handling

Miscellaneous credit adjustment

Miscellaneous charge

After you enable a line type, you can add it as an invoice line to the invoice on the Add Invoice Line dialog box.
Alternately, you can specify its value as a pro rata Additional Charge if you check Use Pro Rata in the
Additional Charges area on the Summary tab of the Invoice Details page (see below). For more information, see
Creating Invoices.

Enabled line types can also be read from incoming EDI invoices. Any EDI additional charges that do not match
enabled types are added to an invoice line Overhead.

To configure which additional charges are available to add to invoices:
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1. Enable invoice_split_additional_charges in the Customer Parameters mapping table.

2. On the Invoice Line Types code table, click Customize next to the line type.

3. Select the checkbox in the Enabled column to enable/disable the invoice line type.

4. To change the text that appears for a line type on the invoice, enter new text in the Description column.
In this example, Sleeving is enabled.

Invoice Line Types Code Table

5. When you are done, click Customize at the top or bottom of the page.

You can enable up to five additional line types
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Managing Funds and Ledgers
To manage funds, you must have the following role:

Fund Manager

To manage ledgers, you must have the following role:

Ledger Manager

You manage funds and ledgers from the Funds and Ledgers page (Acquisitions > Acquisitions
Infrastructure > Funds and Ledgers).

You can add funds only to ledgers that have already been defined. You can add encumbrances to the fiscal period
of a fund or ledger only if:

The fiscal period is Active

The date range of the fiscal period includes the current date

Alternatively, you can add encumbrances to a fund’s fiscal period prior to or after the actual fiscal period, provided
the relevant fields are configured in the Rules section of the Summary Details page (Acquisitions > Acquisitions
Infrastructure > Funds and Ledgers, click Add Ledger). For details on the fields in the Rules section, see
Ledger Rules.

Fund Transaction Terminology

A fund can be allocated or summary.

A summary fund is not used for ordering and invoicing, but provides aggregate reporting on subordinate
funds. You can add other funds to this type of fund.

An allocated fund contains money that has been paid out or has been reserved for an open purchase.

A transaction can be an allocation, encumbrance, disencumbrance, or expenditure:

An allocation adds money to the fund, increasing its available balance.

An encumbrance indicates money that is expected to be paid out, as the result of a PO line. This decreases
its available balance. The encumbrance is closed if there is an equal disencumbrance linked to the same
PO line.
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An expenditure subtracts money from the fund, decreasing its available balance. Adding an expenditure
lined to a PO line increases the value of the disencumbrance linked to that PO line.

A disencumbrance is added or increased when adding an expenditure linked to the same PO line as an
encumbrance. There is never more than one disencumbrance for any encumbrance. For example:

If a fund has a $100 encumbrance for a PO line. An invoice for $50 linked to that PO line is received.
The encumbrance remains $100, an expenditure of $50 is added, and a disencumbrance of $50 is
added.

After receiving another $50 invoice for the PO line, there are now two expenditures (each for $50), an
encumbrance of $100, and a disencumbrance of $100. The encumbrance is now considered fully paid
and is closed.

A fund's available balance is its allocated balance, less encumbrances and expenditures.

Exchange Rate Handling in Funds

When a PO line creates an encumbrance in a currency that is different that the fund's currency, the available
balance is calculated based on the exchange rate between the two currencies. The exchange rates and calculated
values of open encumbrances in a foreign currency are recalculated weekly by the Recalculate Exchange Rate
Based on Current Date job (see Viewing Scheduled Jobs). The exchange rate and date of a disencumbrance are
always the same as its related encumbrance.

In the following example, a purchase is made in USD on Thursday, and the invoices are received on Sunday and
Tuesday.

Exchange Rate Recalculation Example

Date Events
Exchange
Rate
EUR/USD

Encumbrance Expenditures Disencumbrance

Thursday
A USD 100 PO Line
is sent, to be paid
from a EUR fund

0.91

Value: 100
USD
Calculated:
EUR 91
Exchange
Rate Date:
Thursday
Status: Open
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Date Events
Exchange
Rate
EUR/USD

Encumbrance Expenditures Disencumbrance

Friday 0.92

Value: 100
USD
Calculated:
EUR 91
Exchange
Rate Date:
Thursday
Status: Open

Saturday The recalculation
job runs 0.93

Value: 100
USD
Calculated:
EUR 93
Exchange
Rate Date:
Saturday
Status: Open

Sunday
An invoice for $50
associated with this
PO line arrives

0.94

Value: 100
USD
Calculated:
EUR 93
Exchange
Rate Date:
Saturday
Status: Open

1: 47 EUR (50 USD
based on Sunday's
exchange rate date)

Value: 50 USD
Calculated: EUR
46.50
Exchange Rate
Date: Saturday

Monday 0.92

Value: 100
USD
Calculated:
EUR 93
Exchange
Rate Date:
Saturday
Status: Open

1: 47 EUR

Value: 50 USD
Calculated: EUR
46.50
Exchange Rate
Date: Saturday

Tuesday

An invoice for $50
associated with this
PO line arrives
The PO line is fully
paid and the
encumbrance is
closed.

0.90

Value: 100
USD
Calculated:
EUR 93
Exchange
Rate Date:
Saturday
Status: Closed

1: 47 EUR
2: 45 EUR (50 USD
based on Tuesday's
exchange rate date)

Value: 100 USD
Calculated: EUR
93
Exchange Rate
Date: Saturday
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Browsing Bibliographic Headings

To configure metadata, you must have one of the following roles:

Cataloger

Catalog Manager

Catalog Administrator

Alma provides better cataloging management utilities in the form of bibliographic headings browsing for supporting
various cataloging workflows. With this feature, you can now browse by author name, subject, series, and title.

There is a known issue that when a record is deleted in Alma, the headings associated with that record are
still available when browsing bibliographic headings. This will be fixed in a future release.

To browse bibliographic headings:

1. Open the bibliographic headings browsing options in the MD Editor using one of the following methods:

a. Click Browse Bibliographic Headings (Resource Management > Cataloging). The MD Editor page
appears with the bibliographic headings browsing options.

Bibliographic Headings Browse in the MD Editor

b. Open the MD Editor (Resource Management > Cataloging > Open Metadata Editor), and click Browse
Bib Headings in the Tools menu.

2. Select the type of headings to browse from the following options:

Names (the default option)

Series

Subject
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Title

When you select a headings type option other than the default (Names), the page refreshes to display the
appropriate options for the headings type selected.

3. Complete the browsing options for the action you want to perform. See the table below for a description of
these options.

Headings Type Options

Names

Source Code – Select one of the following options:

Corporate Name

Meeting Name

Personal Name

Uniform Title

Search Value – Enter a names value for which you want to search.

Series

Source Code – Select one of the following options:

Corporate Name

Meeting Name

Personal Name

Uniform Title

Search Value – Enter a names value for which you want to search.

Subjects

Vocabulary – Select one of the vocabularies from the available options in the drop-down list such as Library of Congress Subject Headings or U.S. National
Library of Medicine, Medical Subject Headings. The options that appear vary depending on which vocabularies you have configured in your system.
Source Code – Select one of the following options:

Chronological Term

Genre/Form

Geographic Name

Medium of Performance

Topical Term

Search Value – Enter a names value for which you want to search.

Title Search Value – Enter a names value for which you want to search.

4. Click Go. The browsing results appear. The results appear in the following columns:

Column 1 – An icon to indicate whether the bibliographic subject heading is connected to an authority
record.
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Column 2 – The number of bibliographic record headings found for a particular subject, name, series, or title
headings row. If there are more than 20 headings found for a particular row, this column displays 20+.

Column 3 – The bibliographic record headings subject, name, series, or title found.

Column 4 – A View button for viewing the complete bibliographic record.

Bibliographic Headings Browse Results for a Subjects Browse

5. Use the less than/greater than symbols (< >) to browse the list backward and forward. As you page backward
and forward, the first row of the page you are viewing appears as the last row of the previous page.

6. When you have located a headings record that you want to view in more detail, click View for that row. The MD
Editor opens in split-screen mode to display the additional information. For bibliographic headings records
identified with the authority icon, the detail in the split-screen view displays both an Authority tab and a
Bibliographic Records tab. The Authority tab presents the authority record that is associated with the
bibliographic headings record. The Bibliographic Records tab shows the total number of records found in
parentheses. In the example below, 3 records have been identified. When there are more than 20 records (that
are identified by 20+ in the initial results list), the exact total of bibliographic records displays in parentheses on
the Bibliographic Records tab.
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View Headings Record Detail in Split-Screen Mode – Authority Tab

Ex Libris, a ProQuest Company
66



View Headings Record Detail in Split-Screen Mode – Bibliographic Records Tab

20+ Records Example

From the Bibliographic Records tab, you can click View (or the title link) to display the MARC record for a
particular bibliographic record. While viewing the MARC record, you can page forward and backward through
the bibliographic records when there is more than one using the list number or greater than/less than symbols.
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Paging Forward and Backward When There are Multiple Bibliographic Records
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Using the Authority Control Task List

To use the Authority Control Task List, you must have one of the following roles:

Cataloger

Catalog Manager

Catalog Administrator

The Authority Control Task List provides more details regarding authority record updates and the authority control
process that are relevant to the institution's bibliographic record headings.

The Authority Control Task List makes it easier to manage cataloging maintenance tasks. Specifically, this list
highlights authority headings updates that require manual intervention. The following is a list of changes
highlighted in the Authority Control Task List, some of which may require manual intervention due to a linking
issue, a preferred-term correction issue, or deleted/updated authority record:

Linking – Bibliographic heading found no matching authority heading

Linking – Bibliographic heading found multiple matching authority headings

This issue may occur as a result of times, for example, when the Library of Congress splits one subject
heading into two subject headings such as Nurses and nursing is split and replaced with Nurses and
Nursing. It may also occur when the system finds a Community Zone authority record and a local authority
record match.

Linking – Bibliographic heading linked to an authority record

Preferred term correction – Bibliographic heading updated

Preferred term correction – Bibliographic heading found no authorized term

Authority record deleted – Unlinked the bibliographic heading

Authority record updated

From the Authority Control Task List page, you can choose to view the tasks from the Review tab or the All tab.
The Review tab contains a list of all the tasks that require some action, and the All tab displays all the tasks that
have not yet been dismissed.
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These lists can be filtered by date or by the type of action/change.

For more information, see the Authority Control Task List video (1:37 min.).

To process changes with the Authority Control Task List:

1. Open the Authority Control Task List page (Resource Management > Cataloging > Authority Control Task
List).

Authority Control Task List Page

2. Filter by Submit Date or Action to view the tasks upon which you want to focus.

Authority Control Task List Page – Filtering

Review Tab Action Filter
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All Tab Action Filter

3. On the All tab, you can also choose to limit your view to certain columns by using the Columns drop-down list
to make selections.

Columns Filter

4. From the list, click a title link (from the Title column) to view a record that you want to process.
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Authority Control Task List Page - Title Link

While reviewing the list, sometimes you may notice that the same record (MMS ID) may be identified with two
different errors. This may be caused by the system checking the Community Zone authority records and also
checking local authority records for a match.

The title opens in the MARC Record Simple View page from which you can click Edit to make any changes.
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MARC Record Simple View Page

In a future release, edit options will be provided from the Authority Control Task List page.

5. When you have completed your review and/or change, select the Dismiss action button. You may also choose
to work with multiple records by selecting the row check box in the check box column, choosing Dismiss
Selected, and clicking Execute.
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Assign Controlled Vocabulary

Select a controlled vocabulary (CV) from the drop-down list and click Assign. The options in this list are
configured in Configuring Controlled Vocabulary Registry.

For your convenience, you may use the Create New CV Value section to add controlled vocabulary terms.
The terms that you add here only apply to the field that you are editing. If you want to use these terms with
another/different field, use the Controlled Vocabulary Registry (refer to Configuring Controlled Vocabulary
Registry) to create a CV that may be used for more than one field.

To add a new controlled vocabulary value in the Create New CV Value section, enter a code and
description and click Add. When you are finished adding terms, click Assign.

First Indicator – Make any required changes.

Second Indicator – Make any required changes.

5. Click Save. The field changes are saved in the metadata profile.

6. Click Deploy.

Controlling the Display and Access of Global Authorities in the MD Editor

Support is provided for controlling which global authorities can be viewed and/or accessed in the MD Editor.
Metadata configuration options in Resource Management allow you the capability to tailor the display of authority
options when working in the MD Editor. With this capability, you can limit the display of options to only the
vocabularies that you commonly use versus all that might be available.

This capability is specific to institutions that have had their authority usage policy configured for local
authorities.

To change global authority display/access in the MD Editor:

1. Open the Metadata Configuration List page (Resource Management > Resource Configuration >
Configuration Menu > Cataloging section > Metadata Configuration). The Metadata Configuration List
page appears.
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Metadata Configuration List Page

The Metadata Configuration List page has the following sections:

Active Profiles

Authority Vocabularies

Each section contains a Columns drop-down list to filter the columns that display on this page. When columns
have been filtered from view, the View Hidden actions button appears. For rows with local vocabularies, the
button is labeled Actions and, in addition to the View Hidden options, contains other actions that you can
perform.

Key to this capability is the Managed Locally column that allows you to identify which vocabularies are locally
managed and activate them for display in the MD Editor (and the Import profile). To supplement this column, is
the Managed in Community column that identifies the vocabularies that are maintained in the Community
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Zone and updated automatically using the existing harvesting process. This column is for informational
purposes only; there is no option to activate/deactivate the check marks.

2. Select the check marks in the Managed Locally column to identify the vocabularies that you want displayed in
the MD Editor (and the Import profile). The vocabularies that you select display in the Templates and Records
tabs in the MD Editor and the File > New record options. These selections also determine which vocabularies
appear in the drop-down list for the Vocabulary code parameter on the Import Profile Details page.

Editing MARC-Based Profiles with Extension Packs

Extension packs for the metadata profiles enable you to adapt MARC-based bibliographic, holdings, and authority
profiles with additional fields, subfields, and indicator values, repeating/nonrepeating and mandatory/
nonmandatory specifications and URLs for online help for regional needs. This includes the MARC 21, UNIMARC,
and KORMARC profiles (but not Dublin Core). With these MARC profile extension packs, you can load and use
regional adaptations to the MARC standard.

See Extension Pack .xsd for the extension pack schema and the Extension Pack .xml File Example for additional
information and an example .xml file.

To add an extension pack:

1. Create a .xml extension file (see Extension Pack .xml File Example for more information).

2. Click the link for the profile you want to extend on the Metadata Configuration List page (Resource
Management > Resource Configuration > Configuration Menu > Cataloging > Metadata Configuration).

For this example, the MARC21 Bibliographic link is used. The Profile Details page appears with the Add
Extensions and Remove Extensions buttons.

Profile Details Page with Add/Remove Extensions Buttons

3. Click Add Extensions. The Add Extensions File page appears.

Ex Libris, a ProQuest Company
76



$0 is automatically added to the control field from which you initiated this process with the originating system ID
pulled from the authority record’s 035 $a.

$0 Created

5. Save your bibliographic record.

Now that this control field contains $0, pressing F3 displays only the authority record with the originating ID that
is stored in $0.

Only the Authority Record with the Originating ID stored in $0 is Displayed

Authority Control Based on Multiple Authority Identifiers in a Bibliographic Record

For institutions that require the ability to link bibliographic to authority headings using a direct ID that is not
necessarily the originating system ID and with multiple system IDs specified, Alma provides support to accomplish
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this with the Direct ID Prefix in the Metadata Configuration (Resource Management > Resource Configuration
> Configuration Menu > Cataloging section > Metadata Configuration).

For more information about configuring the Direct ID Prefix, see Adding a Local Authority Definition on this page.

Specifically, this is designed for bibliographic records with the linking record ID identified in $0 of the 650 field (see
the illustration below) and the matching ID located in the 035 $a of the authority record (see the illustration below).
This capability provides support for instances where the 650 field may contain more than one $0 where the intent
is to specify linking system IDs for different systems.

Bibliographic Record with 650 $0

Authority Record with 035 Matching System ID to the Bibliographic 650 $0 ID Above

Based on the Direct ID Prefix that you specified in the Metadata Configuration, the system looks for a prefix
match and then looks for an originating system ID match. In the above illustrations, the bibliographic record 650 $0
prefix/originating system ID, (DE-588)4017214-4, matches the authority record 035 $a (the second 035 entry).

When you are working with bibliographic records in the MD Editor and you enter 650 $0 with a valid prefix and
record ID and click the Save icon, the system looks for an authority record that has a matching 035 $a. When a
match is found, it displays a linking icon (to the left of the 650 record) indicating that it has linked to an authority
record. Click the linking icon to open the authority record in the split screen.
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Bibliographic 650 $0 Matching/Linking to the Authority 035 When Saved (Click Linking Icon to View Authority)

When you are working with bibliographic records in the MD Editor, you can also press F3 from the active 650 field
that has no $0 specified, and the system presents any headings matches that it finds. From the authority headings
list, View and/or Select a headings record (see below).

View the Authority Headings Record

Select the Authority Headings Record
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When you Select a headings record, the matching authority record 035 $a value is copied to the bibliographic
record's 650 $0. If there is no 035 $a value, the system copies the standard record ID number to $0.

Authority Headings Record 035 $a Value Copied to 650 $0

Working with Multilingual Authority Record Preferred Terms

Alma provides the capability for institutions to work with authority records that have preferred, non-preferred, and
related terms in more than one language. This has been implemented in the following manner:

The Multilingual parameter needs to be set to Yes for authority records. For local authority records, you need
to specify this parameter in the Metadata Configuration. For Community Zone managed authority records, this
setting needs to be configured by Ex Libris at the Community Zone level. For more information, see Adding a
Local Authority Definition on this page.

For MARC 21 records, the language code (such as lat, heb, ara, and so forth) for all preferred, non-preferred,
and related terms is entered in $9.

$9 lat Record Entry
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$9 lat Headings Display

For UNIMARC records, the language code for all preferred, non-preferred, and related terms is entered in $7.
Specifically, the system uses positions 5 and 6 of $7.

Positions 5 and 6 in $7

In a multilingual authority record, the preferred term is duplicated for each language. Non-preferred terms are
entered as necessary for each language.

Multiple $9 Entries with Duplicated Terms for Each Language

When a non-preferred term is used in a bibliographic record, Alma updates the bibliographic record using the
preferred term of the same language.

When F3 is used (from the appropriate bibliographic fields) in the MD Editor to display a list of headings, the
headings list is displayed as follows:

If there is a language code (specified in the MARC 21 $9 or the UNIMARC $7) in the bibliographic record,
only the headings that match the language are displayed.

If there is no language code specified in the bibliographic record, all of the matching headings in all
languages are displayed. The language code in the authority/bibliographic headings records is ignored.

Validation of records is handled in the following manner:
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For authority records, Alma checks for the Multilingual setting. If the Multilingual setting is No, only one
preferred field is allowed in the MARC 21 1XX or the UNIMARC 2XX. If the Multilingual setting is Yes and
there is more than one preferred term, Alma checks for a language indication in the MARC 21 $9 or the
UNIMARC $7, positions 5 and 6.

For bibliographic records, validation of $9 has been enhanced to include $9 in the fields specified in the
table below.

MARC 21 Bibliographic Fields KORMARC Bibliographic Fields

084 084

382 100-199

440 382

490 440

648 490

650-651 600

654-655 610-619

748 630

751 648

810-819 650-651

830 654-655

700

710-719

730

748

751

800

810-819
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MARC 21 Bibliographic Fields KORMARC Bibliographic Fields

830

Publishing to Primo enriches the bibliographic records with the preferred, non-preferred, and related terms of
all languages.

For more information, see the Multilingual Authority Record Support video (0:48 mins).
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MD Editor – In the MD Editor, the angle brackets and the text within the brackets appear in the area where
cataloging records are entered. However, where text such as a title appears in the MD Editor, the angle
brackets are removed (see the examples below).

Handling of Non-Filing Indicators in the MD Editor (Cataloging and Display)

Handling of Non-Filing Indicators in Search Results

Using Non-Filing Indicators in KORMARC

When working with KORMARC records, searching in the Alma repository and browsing headings has been
enhanced to include logic for processing records with non-filing indicators and characters. Sorted results lists
ignore non-filing characters and when browsing headings, the non-filing characters are ignored. For example,
articles such as a, an, and the can be ignored.
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In KORMARC, non-filing characters are identified by surrounding the non-filing text in parentheses at the
beginning of $a and an indicator value of 1 in either the first or second indicator position as identified in the table
below.

KORMARC Bibliographic Record with Non-Filing Characters

Indicator Position KORMARC Field

1 630, 740

2 130, 222, 240, 242, 243, 245, 440, 490, 730, 830

Even though the non-filing characters are ignored for sorting purposes, the system displays the complete entry.
For example:

Record: 245 11 $$a (The) Journal of product innovation management.

Sort: Journal of product innovation management.

Display: The Journal of product innovation management.
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Sorted KORMARC Results with Non-Filing Characters

Using the same KORMARC record example above, the result The Journal of product innovation management.
is returned when any of the following searches have been specified:

Keyword search contains the or journal

Search phrase contains the journal of product or journal of product

Search starting with contains the journal of product or journal of product
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Contributing to the Community Zone - Normalization,
Merge, and Indication Rules

To share rules in the Community Zone, you must have one of the following roles:

Cataloger

Cataloger Extended

Catalog Manager

Catalog Administrator

Contribution privileges that can be activated by Support have been added for the cataloging
roles identified above. Contact Support to have the Contributor privilege activated for these
roles per your requirements.

In the Alma Community Zone, a dedicated area is provided for sharing normalization, indication, and merge rules
between institutions. From the Rules tab in the MD Editor, private or shared rules can be contributed to the
Community Zone.

For more information, see Contributing Normalization Rules to the Community Zone (3:09 min.).

Sharing Rules in the Community Zone

This section describes how to share normalization rules in the Community Zone. These same steps can be applied
to merge rules and indication rules since they are shared in a similar manner.

To share normalization rules in the Community Zone:

1. Open the MD Editor (Resource Management > Cataloging > Open Metadata Editor).

2. Select the Rules tab, expand the Normalization rules folder, and expand the Private or Shared folder where
the rule that you want to share in the Community Zone is located.
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MD Editor Rules Tab with Expanded Normalization Rules Folder

3. Locate the rule that you want to contribute. Use the filtering capability to display a shorter list of rules from
which to choose.
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Filtering Rules

4. Select the rule to be shared in the Community Zone. The list of actions that can be performed appears.

Rules Actions

5. Select Contribute to share the rule in the Community Zone. The Rule Sharing dialog box appears.

The Name parameter is required and needs to be unique. If the system finds another rule by the same name in
the Community Zone, it will apply a numeric suffix (Contributed 1, Contributed 2, Contributed 3 and so forth) to
make the name unique.

Even though the following parameters are optional, they provide key pieces of information that enable the most
effective use of the shared rule and should be completed as part of your best practices for rule sharing:

Description

Contact name

Contact email

The Contact name and Contact email parameters are automatically prefilled in the Rule Sharing dialog box
with the user’s information (or you can manually override this with other contact name/email information)
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Contact Name and Contact Email Automatically Filled In

When rules are stored in the Community Zone, other users can see this information. A full, detailed description
can enable interested users in determining/confirming whether a rule meets their needs without having to open
and review the rule details. The Description parameter can be a maximum of 4,000 characters in length.

Providing contact information enables users to collaborate, perhaps, to develop extensions to a rule or provide
notification if a rule becomes broken.

6. Click OK. A confirmation message appears when a rule is successfully contributed.

Confirmation Message of Successful Contribution

The rule is copied to the Community Zone and appears in the Community folder when you expand it.

Shared Rule Appears in the Community Folder
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In the Community folder, the rule is identified with the following components:

Rule name

Contrib <numeric suffix>, if required to make the name unique

Contributed by: <institution name> (For rules contributed by Ex Libris, it displays Contributed by: Alma
Community Zone.)

To copy a shared normalization rule from the Community Zone:

1. Expand the Community folder in the Normalization rules folder under the Rules tab in the MD Editor
(Resource Management > Cataloging > Open Metadata Editor).

2. Select the rule that you want to use. When you point to the rule, the Description for the Rule appears. This
provides additional information to help you identify the rule that you want to copy. The system also uses
distinguishing icons to help you identify which rules displaying in the Community folder were created locally by
your institution or are rules from the Community Zone created by a different institution.

Community and Institution Icons

3. Click Copy from the list of actions. The Normalization Rules Properties dialog box appears. In addition to the
rule name and description, the properties provide the following information:

Name of the institution that created and contributed the rule

Contact name and email address for the contributed rule
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Date that the rule was last updated

Copy Normalization Rule from the Community Zone

4. Select from the Private, Shared, and Enabled options to identify the attributes for the rule after it is copied
from the Community Zone to your institution.

5. Click Save. The rule opens in the MD Editor working space.
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Copy of the Normalization Rule from the Community Zone Opens in the MD Editor

6. Click Save.

In addition to the Copy action:

If you are the contributing institution, you have the option to Delete the rule from the Community Zone

If you try to delete a contributed normalization rule from the Community Zone and it is being used by any other
process, import profile, and so forth, there is a validation check that prevents it from being deleted and a pop-
up message appears indicating that the normalization rule cannot be deleted and that you need to remove the
related process first.

For institutions that have a copy of a rule that is subsequently deleted from the Community Zone, the copy may
continue to be used as if it was one created by the institution.

All institutions have the View action option

A Properties action is available for viewing a rule's properties from the Community
Zone.
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Properties Option for the Community Folder

Community Folder Rule Properties

In a collaborative environment, if you would like to copy normalization rules from the Community Zone to the
Network Zone and not the Institution Zone, copying should be done in the Network. That is, from the Network
system, you need to perform the Copy action and copy from the Community folder to the Shared folder in that
system. When copied in this manner, the Network copy appears in the Shared folder of the member institutions.

Other miscellaneous enhancements provided in the April 2016 release are:

Tooltips include Contributed by information in addition to the rule name

Unneeded labels (Contributed by, Contact name, and Contact email) have been removed from the new rule
dialog box in the MD Editor (File > New > Normalization rules, File > New > Merge rules, and File > New >
Indication rules)
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Configuring Representation Label Templates

You can create a template that can be used to create a label for partial representations. These representations are
used when a bibliographic record is not fully represented by a single representation. For more information, see
Editing Representation Metadata and Content.

To create representation label templates:

1. From the Representation Label Template Rules page (Resource Management > Resource Configuration >
Configuration Menu > General > Representation Label Templates), click Add Rule. The following appears:
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Representation Label Template Setup Editor

2. In the Name field, enter a name for your template.

3. In the Input Parameters section, select a name, operator, and value from the drop-down lists and click Add
Parameter.

Repeat this step as necessary.

4. In the Output Parameters section, select fields and enter the prefixes and suffixes you want Alma to use to
create the representation labels.

5. Click Show template to see an example of how the label will appear.

6. Click Save.

The template is available to create labels for partial representations.
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Booking Workflow
The following is an illustration of the booking requests workflow that governs the way the booking process is
managed. The workflow outlines the configuration tasks necessary to implement booking requests, as well as the
procedure for booking items in Alma.
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Booking Workflow

The following is a detailed description of the steps within this workflow (with the numbers corresponding to the
numbers in the diagram):

1. Invoke the relevant Booking configuration settings, as follows:

a. Policies – You create the relevant booking policies to enable parameters for booking requests (see
Configuring Policies)

b. Terms of Use – You create booking terms of use to invoke the configured booking policies (see
Configuring Terms of Use)

c. Rules – You create rules that indicate which booking terms of use are to be applied for the specified
fulfillment unit locations (see To add fulfillment unit rules:)

2. Create a booking request using one of the following methods:

a. Repository Search – Performed by the Fulfillment Services Operator on behalf of a patron

b. Primo – Performed by a Patron

3. Alma verifies the availability of the item, as follows:

a. If the item is on loan, it is unavailable until the item’s due date is reached.

b. If the item is on the hold shelf, it is unavailable until the hold shelf period is over and the item’s due date is
reached.

If the item is being processed by a work order, it is unavailable before the work order’s end date.

If the item is neither on loan nor on the hold shelf or processed by a work order, it is available and the
booking request can be processed and completed.

4. The booking request is processed and submitted – see step 3 through step 11 in To create a booking request:.

5. The submitted booking request enters the standard request workflow for processing at
the shelf. This includes steps for picking up booked items from the shelf and placing them on the hold shelf. If a
preview period has been defined in the booking request's terms of use, the workflow process begins from the
preview time. Otherwise it begins with the booking time. The booking request is considered active at the point
that its workflow process begins. At that point the request will show up in the relevant Pick From Shelf task list
if the resource is available, or be activated when the item is scanned in or returned if the resource was not
previously available.Requests are considered expired when their booking request end time arrives.

Booking requests will participate in the standard request workflows and can be seen in the Pick from Shelf and
Hold Shelf task lists. There is a new facet for the expired hold shelf task list to filter the different request types.
When filtering for booking requests, the sort order is by start date/hour, in ascending order. It is not possible to
update the expiration of booking requests as the expiration request is the booking end time. Additionally, a booking
request may be placed for pickup at another location if the booking terms of use allows that.
A booking request has higher priority than a hold request. If a hold request cannot be completed considering the
hold shelf period and the loan period, it will not be activated until after the booking request is completed.
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RFID Support

To configure an RFID integration profile, you must have the following role:

General System Administrator

RFID readers may be used for scanning item barcodes and for registering their check-out and check-in. The
support is currently functional for 3M RFID Staff Workstation 896. After the RFID integration profile is added, a
connection icon will appear in the main menu bar as long as a location is selected from the Currently At drop-
down.

For more information about RFID Support, see the RFID support video (1:51 mins).

If the RFID connection is not currently active, it will appear as follows.

Alma Menu Bar - RFID Disconnected

Clicking on the connection icon will open an RFID communication pop-up window. This enables the
communication with the reader and must be left open in order to read from or write to the reader.

RFID Communication Window

Ex Libris, a ProQuest Company
100

http://knowledge.exlibrisgroup.com/
http://knowledge.exlibrisgroup.com/
http://knowledge.exlibrisgroup.com/Alma/Training/01_What's_New_Videos_2016/09_April_2016_Release/RFID_Support


The connection icon on the menu bar changes to show that the connection has been made.

Alma Menu Bar - RFID Connected

The active connection will be maintained per user and desk/department. When switching to a new desk, you will
need to activate the connection again by clicking the connection icon.

Clicking the blue icon next to the search bar will activate the RFID reader to read the barcode of the item that is
currently at the counter, and display the item. All input boxes that accept a barcode will show the blue icon as long
as the RFID connection is active. These boxes are found in the following locations: Scan In, Return Items, Patron
Services, Repository Search, Receive New Material, Physical Item Editor, Quick Cataloging, and Persistent
Search (throughout Alma). Additionally, while on a screen that has the icon to read a barcode, the keyboard
shortcut, Alt+A, will also activate the reader to display the listing.

Using the RFID reader to scan and loan an item will disable the security bit on the RFID tag. Returning the item
will re-enable the security tag.

To configure the RFID integration profile:

1. Access Administration > General Configuration > Configuration Menu > External Systems > Integration
Profiles. Click Add Integration Profile. Enter a code and name for the integration profile.

Integration Profile – Step 1

2. Select RFID from the Integration Type drop-down list.
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Integration Profile – Step 1 with RFID Selected

3. Select the RFID system that you are using from the System drop-down list, and click Next.

4. Select the Active check box to make this an active RFID definition.

5. Enter the URL for the RFID system to which your RFID device is attached.

Integration Profile – Step 2

6. Configure and/or review the following definitions using the links provided:

RFID Material Type Definition (see the Configuring the RFID Material Type Definition section below)
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RFID Item Policy Definition (see the Configuring the RFID Item Policy Definition section below)

Mapping of RFID Fields to Alma Fields (see the Mapping the RFID Fields to Alma Fields section below)

7. Click Save.

For more information on configuring RFID, see https://developers.exlibrisgroup.com/alma/integrations/rfid.

Configuring the RFID Material Type Definition

Since the RFID reader requires numeric content (that varies among RFID vendor implementations), the RFID
Material Type code table provides you the ability to map alphabetic material type codes that you currently have
defined in Alma to numeric values.

To configure the RFID Material Type code table:

1. Click the RFID Material Type Definition link in your RFID Integration Profile. The RFID Material Type code
table page appears.

RFID Material Type Code Table Configuration

In a Network environnment, the Manage Table in Network options appear.
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RFID Material Type Code Table Configuration in the Network - Manage Table in Network Button

RFID Material Type Code Table Configuration in the Network - Save and Distribute/Stop Network Management

2. In the Create a New Code Table Row section, select one of the existing material type codes from the Code
drop-down list, enter a numeric value for the Description (mandatory), and click Add Row. Continue adding
rows for each Alma material type to which you want to assign a numeric value for the RFID reader.
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RFID Material Type Rows Added

3. Click Customize (or Save if you have previously edited this code table).

Configuring the RFID Item Policy Definition

Since the RFID reader requires numeric content (that varies among RFID vendor implementations), the RFID Item
Policy code table provides you the ability to map alphabetic item policy codes that you currently have defined in
the system to numeric values.

To configure the RFID Item Policy code table:

1. Click the RFID Item Policy Definition link in your RFID Integration Profile. The RFID Item Policy code table
page appears.

Ex Libris, a ProQuest Company
105



RFID Item Policy Code Table Configuration

In a Network environnment, the Manage Table in Network options appear.

RFID Item Policy Code Table Configuration in the Network - Manage Table in Network Button

RFID Item Policy Code Table Configuration in the Network - Save and Distribute/Stop Network Management

2. In the Create a New Code Table Row section, select one of the existing item policy codes from the Code drop-
down list, enter a numeric value for the Description (mandatory), and click Add Row. Continue adding rows for
each Alma item policy to which you want to assign a numeric value for the RFID reader.
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RFID Item Policy Rows Added

3. Click Customize (or Save if you have previously edited this code table).

Mapping the RFID Fields to Alma Fields

The Mapping of RFID Fields to Alma Fields link displays the RFID Fields mapping table settings. The settings
on this page determine what information is written to the RFID tag. From this page, you can see which fields are
enabled to be written to the RFID tag. In addition, you can see one of the following Alma field settings that has
been mapped to each of the RFID tag fields:

Ex Libris, a ProQuest Company
107



Alma Fields that can be Mapped

If you need to customize the field mapping or which fields are enable to be written to the RFID tag, contact Support
for assistance.

Configuring Library Codes for RFID

Since the RFID reader requires numeric content (that varies among RFID vendor implementations), the Alma
library configuration (Administration > General Configuration > Configuration Menu > Libraries section >
Add a Library or Edit Library Information) provides a parameter for specifying a numeric code value in addition
to the alphanumeric code used within Alma. For example, the 3M LibraryID parameter requires a numeric (integer)
value. The Numeric Code for RFID parameter needs to be configured in order to write RFID content.

RFID Library Code (Numeric)

For more information, see Adding/Editing Institution Libraries.

Configuring Location Codes for RFID

Since the RFID reader requires numeric content (that varies among RFID vendor implementations), the Alma
location configuration (Fulfillment > Fulfillment Configuration > Configuration Menu > Physical
Locations when configuring a specific library) provides a parameter for specifying a numeric code value in
addition to the alphanumeric code used within Alma. The Numeric Location Code for RFID parameter needs to
be configured in order to write RFID content.
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RFID Location Code (Numeric)

For more information, see Configuring Physical Locations.

Transaction Log

The RFID Communication window that opens when you click the connection icon can be expanded to display a list
of request and response RFID transaction activity. Use this log to help resolve any failed transaction with your
RFID communication. Include a copy of this log with any RFID Salesforce issue that you may submit.

RFID Communication Window Transaction Log
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On the library level (see Adding/Editing IP Definitions for a Library)

On the campus level (see Editing a Campus)

2. In the Prefer remote storage field, select Yes to assign priority to remote storage items when viewing results
in the Get It tab, publishing to Primo, or the Primo RTA.

3. Click Save.

Configuring Other Settings

The following other settings are available:

Enable Display of License Information - Select to enable the display of an online resource's license information
in the View It tab. For more information, see Displaying License Information in the View It Tab.

Max. Number of Representations in View It - the maximum number of digital representations that are displayed
in the View It tab. If there are more representations to display than the maximum number configured, a More...
link appears. Click More... to display the full list of representations available in a new browser tab. (The default
value is set with the viewit_max_representations_displayed parameter. For more information,
see Configuring Other Settings.)

Mapping Primo Views to Libraries
To map Primo view to libraries, you must have one of the following roles:

General System Administrator

Fulfillment Administrator

To map Primo views to libraries:

1. Access Fulfillment > Fulfillment Configuration > Configuration Menu > Discovery Interface Display
Logic > Primo View to Libraries.
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Mapping a Primo View to Libraries

2. Enter the Primo view name and the Alma library code which will appear in the filtered view. A new row may be
added for each library that will appear in a Primo view.

3. Click Customize.

Ex Libris, a ProQuest Company
111



Integration of the Aleph Central Catalog

Alma supports the use of the Aleph Central Catalog to allow Alma institutions to perform the following functions:

Copy cataloging from the central catalog to Alma

Contribute changes to the central catalog from Alma

Publish inventory to the central catalog from Alma

Import changes from the central catalog to Alma

In order to use the Aleph Central Catalog, you must configure a central catalog integration profile.

To configure a central catalog integration profile:

1. From the Integration Profile List page (Administration > General Configuration > Configuration Menu >
External Systems > Integration Profiles), click Add Integration Profile. The following appears:

Add integration Profile

2. Enter a Code and Name for the integration profile.

3. Select Central Catalog Integration from the Integration Type drop-down list.

4. Click Next. The following appears:
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Central Cataloging Integration

5. Fill in the fields according to the following table:

Central Catalog Integration

Field Description

Central Catalog System

System Aleph is currently the only available option.

Contribution Configuration

Host The IP address of the Aleph Central Catalog

Port The port of the Aleph Central Catalog

Library The Aleph library in which the document is updated

System Number
Prefix

The library unique system number prefix (for example, BVB0001)

User name The user name in Aleph

Password The password in Aleph

Allow Delete Select to enable the deletion of records in the central catalog

Central Catalog Record Changes Configuration

Host The IP address for the VST server in the Aleph Central Catalog

Port The Aleph Central Catalog port to send the TCP/IP call

Local catalog ID Used to identify the library in Aleph

Username The user name to send to the Aleph Central Catalog

Password The password to send to the Aleph Central Catalog

Data Retrieval Configuration (Z39.50)

Host The IP address of the Aleph Central Catalog
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Field Description

Port The Aleph Central Catalog port to send the Z39.50 calls

Base The database in Aleph to send the Z39.50 query

Search Attribute
The unique identifier of the location of the system number in the central
catalog (equivalent to the Marc 001 field)

Username The user name to send to the Aleph Central Catalog for z39.50

Password The password to send to the Aleph Central Catalog for z39.50

Import

Active
Select Active for the import profile to be active or Non-active for the profile to be
non-active

Schedule To schedule the import process, select a schedule from the drop-down list.

Repository Import
Profile

Select a repository MD import profile on which the bibliographic import is based

Bibliographic Library
Codes (Comma
Separated)

Enter the Aleph library codes that hold the bibliographic records (coma separated)

Last Harvest ID
This field is populated after the first successful run of the process, indicating that
start point of the next run. You can edit this value if you want to retrieve data from
a specific record ID.

6. Click Run if you want to run the integration profile process manually.

7. Click Save.

The central catalog integration profile is configured. You now see the Contribute Record to Central Catalog option
in the MD editor:
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Contribute Record to Central Catalog
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